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Oasis montaj Field
Oasis montaj Field is the Seequent solution for processing geophysical data in the field during
data collection, and building a master survey database. Oasis montaj Field allows you to
import, filter, grid, display your survey data in two and three dimensions. It also allows to you
to log progress reports and export data and maps for sharing with the office or other parties.

In order to get started with Oasis montaj Field, you need to complete a few simple steps:

Create your Seequent ID
Your Seequent ID is your business email address that is registered with Seequent. Your
Seequent ID (email+password) gives you secure access to your Oasis montaj subscription,
Seequent Central, online services, and support resources. A Seequent ID with an active
subscription is required to run the Oasis montaj Field application installed on your computer.
If you already have a Seequent ID, you can install and use Oasis montaj Field.

If you don’t have a Seequent ID, please create one here.

Download Oasis montaj Field
Once you have created your Seequent ID, you can download Oasis montaj Field from My
Seequent. My Seequent is the home for software downloads, learning, training and support for
Seequent Products. The installer for Oasis montaj is available here.

Installing Oasis montaj Field
When the Oasis montaj installer download is complete simply double-click on the installer. In
the interface that appears, check the box next Oasis montaj - Field version. Depending on your
subscription you may see other licensed applications that are available to install.

https://id.seequent.com/register/
https://my.seequent.com/products/oasis-montaj/latest
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1. Once you have selected the application(s) to install, click the Next button.
2. In the next window that appears, check both options
3. Click Install the application
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Oasis montaj Field Menu Overview
Oasis montaj Field offers a comprehensive set of tools that are accessed from a series of
menus, each of which is introduced in this section.

Project Menu
From the Project menu you can:

• Create, open and save Geosoft project files (*.gpf). These GPFs are entirely compatible with
Oasis montaj.

• Manipulate the project parameters

• View and/or Update your subscription

• Inspect the project log file

• Check your subscription and its expiry
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Database Menu
In the Database menu you can:

l Open an existing Geosoft database
l Create an empty database and import data into it
l Import from several standard Geophysical formats
l Export to standard formats
l Save and Load customized views of the database
l Repair and grow a database

Notes:

l You cannot modify environment settings such as fonts and shortcuts, which are set to the
same defaults used in Oasis montaj

l Certain tools are disabled until their prerequisite data is loaded
l Once imported, you can view both scalar and array sensor data
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Database Tools Menu
Once you have imported your survey data, you will likely want to perform the following tasks:

l View the data in profile form
l Merge positioning and survey data into a single database
l Remove spikes
l Remove systematic noise
l Remove repeats
l Mask bad data related to sensor lock or lack of satellite coverage
l Remove unnecessary rows from the database
l Run a report on the data
l Calculate and apply custom math operations
l Apply filters on scalar and/or array data

The tools available under the Database Tools menu facilitate all the above tasks.
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Coordinates Menu
Coordinate Systems and projections which are supported in Oasis montaj are also supported
in Oasis montaj Field.

l To perform operations that require geo-location, such as projection and gridding, you must
assign the channels that contain easting & northing information as Coordinate Channels.
Providing the elevation is optional, although some tools require it

l Normally locational information is recorded in geographic units, however the X & Y
channels for most processes in Oasis montaj field must be in projected ground units.
Reprojecting data from geographic to projected coordinates is simple in Oasis montaj Field

l The Geoid height of the geographic location can be calculated to represent the datum.
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Grid and Image Menu
Oasis montaj Field offers a subset of the gridding methods available in Oasis montaj, which
will allow you to inspect your data visually and compare it to your line locations on a map.
This menu offers:

l Three of the most common gridding methods applied to geophysical data
l The ability to window gridded data
l Utilities to convert gridded data to a multitude of other standard formats
l Display gridded data using many different colour ramps, as well as a shaded relief mode
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Map Menu
In the Map menu you can:

l Create a standard plan map
l Import layouts and structural information from other formats
l Export maps to other standard formats
l Combine all data files represented on a map into a single "packed map" file to share with

other users
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Map Tools Menu
In the Map Tools menu you can:

l Plot survey information

l Annotate maps
l Draw vector data
l Digitize data
l Contour grids
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ArcGIS Tools Menu
In the ArcGIS Tools menu you can:

l Import and display ArcGIS vector data on maps produced in Oasis montaj Field
l Edit vector files in the Oasis montaj project
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QC Tools Menu
A subset of QC tools allows you to inspect if the survey is within project specifications by
performing the following tests:

l Altitude deviation
l Line separation
l Sample spacing

Furthermore, you can apply standard magnetic data corrections such as:

l Diurnal
l Base station
l Heading
l Lag
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3D View Menu
In the 3D View menu you can:

l Plot 3D survey line paths
l Plot a relief surface
l Pack all 3D objects within a 3D View into a single file to share with others
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Data Services Menu
The Data Services menu allows you to download and display:

l Public domain geoscientific data
l Azure Maps imagery
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Data Linking
The Oasis montaj project workspace allows you to work with 3D views, 2D plan maps and
databases at the same time. The data within each of these windows is linked to any others
that are open; the position of the cursor is tracked live in all windows. Windows can be
stacked, tiled or even moved out of the Oasis montaj Field user interface and onto a secondary
monitor.
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Example Workflow
In this section we will walk you through the different stages of a typical workflow in Oasis
montaj, which involves processing some sample magnetic survey data. 

The workflow will consist of the following steps:

1. Create a Geosoft project
2. Import magnetic data into a database
3. Assign an appropriate coordinate system to the database
4. Display the survey lines on a map
5. Display the data in a database profile window
6. Apply a filter to the data to remove noise
7. Decimate the data
8. Mask "bad" data
9. Remove redundant or unnecessary data

10. Break the data into separate lines
11. Grid the data and display the grid on a map
12. Run QC tests and apply corrections to the data
13. Download and display satellite imagery on the map
14. Display the data in a 3D view
15. Merge corrected data into a master database

This is not a comprehensive tutorial, rather it intends to provide you with the fundamentals to
help you get started.
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Create a Geosoft project
When working in Oasis montaj Field, the folder in which you save the Geosoft project file to
will be the location that all tools and processes point to when loading data. Because of this it
will save you time if you store all of your data within the same folder (or sub folders within)
that the project is saved to.

1. Create a working folder and store your survey data within
2. From the Start menu, launch Oasis montaj Field
3. In the window that appears click on Create new project
4. Navigate to your working folder
5. Provide a name for the project file
6. An empty project workspace appears, within which all menus are displayed
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Import Survey Data
Some instruments such as Geometrics magnetometers offer the option to dump the survey
data directly into a Geosoft database. Generally though, survey data is in an ASCII or binary
format with a constant number of items per record. In this case we will import an ASCII data
file (*.csv) with a constant number of fields.

1. From the Database menu, select Import >ASCII
2. You will be prompted to create a blank database in which to import the survey data.
3. In the dialog that appears, click on Create database
4. Provide a name for the database. Standard practice is to use the same base name as

the imported file.
5. Click OK
6. Accept all the default parameters.
7. A blank database is created that we can import the data into.

8. Select the File to import Flight01.csv
9. Click on the Create template button

This opens the Data Import Wizard, which allows you to set the import parameters to suit the
incoming data structure. Once created, the template file can be re-used to import other data
with the same structure

10. In the Data Import Wizard that appears, modify the Start import on row parameter to a
value of 2. Leave all other parameters at their defaults and click Next

11. In Step 2 of the Data Import Wizard, click Next; there is nothing to modify here

The first two steps of the import wizard define the incoming file type and internal structure.
Step 3 of the import wizard allows you to specify which data fields to import and how that data
appears in the database channels.
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By default, all channels would be imported as double precision float values, but it is not
necessary to keep all the data at the highest precision, neither will you need to import all of
the data fields. Furthermore all channels need not start at the same time or be recorded at the
same time interval. The Geosoft database format is flexible and supports this variability. It is
recommended to keep a database as concise as possible. We will proceed to change the
format of some channels and not import some data fields.

12. Move through the data columns and change the suggested defaults. The figures below
highlight some necessary edits, such as:

a. Set the Counter channel to an Integer Data Type
b. Ensure that the Date and Time channels are set to Date and Time Data Format

respectively
c. Geographic coordinate (Latitude and Longitude) channels can be displayed in

degrees/minutes/seconds format, but it is often easier to work with them when
displayed as double precision numbers. You can modify the Data Format after
the data is imported

d. If your data contains null-values, you can specify these in the dummy field.
These values will be replaced with the non-value equivalent in the Geosoft
database, which is an asterisk (*)

e. Data in the Geosoft database is binary and is stored in a columnar order. This
allows to specify the start and increment of each data column individually and
independent of each other

f. The fields of the input file that are of no relevance can be omitted from the
import by selecting the Not Imported option. For the sample data, no channels
need to be omitted from the import
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13. Click Finish to exit the import wizard and return to the Import ASCII dialog

The Import Mode is only relevant if you want to add new data into a database that already
contains data. In that case, using the Append option is best, as it will append the new data to
the existing data, rather than overwriting it.

14. Click OK to complete the import
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15. Click on the Save icon on the database toolbar (or use Ctrl_S) to save the database

In this case the magnetic survey is imported as a single line or group of data; this group is
called LFlight01. We will break the magnetic data into its separate lines later in the workflow.
The black triangles to the right of a channel name indicate that the channel is protected,
which means that you cannot modify the data. Should you need to modify the data of a
channel you can right click on the channel header cell and click on the Protected option. It is
best practice to make a copy of the channel and edit this copy.
The double asterisk in a data cell indicated that the cell is not wide enough to show the
entire numeric or string value. You can widen the column by clicking and dragging it's border.
The single asterisk in a data cell indicated that either the corresponding value is a non-value
(dummy) or the sample increment of this field is bigger than the minimum increment. For
example, the FixQuality channel is recorded at every 5th sample interval relative to the other
channels. The asterisks in this channel indicate that there are no values (hence the dummy
values) at those rows.
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You can change the displayed number of decimals and the number format by right clicking on
a channel and selecting edit. For example you can change the Longitude and Latitude from
decimal degrees to DD:MM:SS representation.

Note than all Oasis montaj Field tools have a comprehensive help file, which can be accessed
by clicking on the ? icon at the top right of a dialog.
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Setting and Reprojecting a Coordinate System
You will have observed that the incoming data is geo-located using Geographic coordinates. In
most cases involving smaller-scale surveys such as this, it is better to work with the data in
projected coordinates, where the unit of measurement is in metres or feet.

In Oasis montaj Field, we can easily reproject the data from a Geographic system into a
Projected system, which creates a new set of coordinate channels in the database:

1. Open the Coordinates menu and select New Projected Coordinate System. The Enter
Existing Coordinate Channels dialog appears

2. From the dropdown list for the X/Longitude and Y/Latitude channels, select Longitude
and Latitude respectively

3. Click Next. The Coordinate System dialog appears.
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4. In the Search field of the dialog, type the geographic cooridnate system of the survey
and then press the Enter key. Most often, this system will be the standard U.S.
Department of Defense WGS 84, as it is with the sample data. The pane that displays
the coordinate systems will update to show relevant systems

5. Select WGS 84
6. Click OK. The Coordinate Channels to Create or Update dialog appears.
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7. In the X/Longitude channel field, type Easting and in the Y/Latitude channel field, type
Northing

8. Click Next. The Coordinate System dialog opens again, this time so we can set the
desired projected coordinate system
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9. In the Search field, type N hemisphere and press Enter.
10. In the Coordinate Systems pane, expand the Projected Coordinate systems folder.
11. Navigate to and select the desired coordinate system, which in this case is WGS 84 /

UTM Zone 13

To filter down the list of projected coordinate systems further, you can enter the zone (13N). If
you do not know the zone, you can start with a general geographic location such as N
Hemisphere, expand it and find the zone based on the longitudinal extent of your survey.

Note that a selected coordinate system can be added to a list of favourites, by clicking on the
Add to Favourites icon. Once you add a system, a Favourites folder will appear at the top of
the Coordinate Systems pane and display all favourites within, making it easier to find
systems that you use often.

12. Click OK

The Easting and Northing channels are added to the database. The final step is to set these
channels as the database coordinate channels, meaning that these channels will be used
whenever the data is gridded, plotted on a map or in a 3D view.

13. Go to the Coordinates menu and select Set Current X,Y, Z,, which opens the
corresponding dialog

14. Use the dropdown lists to set the Current X, Y and Z channels as Easting, Northing,
Altitude respectively

15. Click OK

The designated coordinate channels are denoted in the database by blue x, y and z icons
within the channel header cells, as shown below.
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Rearranging Database Channels
You can rearrange database channels within a database to suit your requirements. For
example, you might want to group your coordinate channels so that you can view them
together.

1. Click once on the header cell of Easting channel to select it, then press your spacebar.
Repeat this process for the Northing channel. This action does not delete the channels
from the database, it just removes them from the display

2. Move the cursor to the channel immediately to the right of the Longitude channel, right-
click on the channel header cell, then select Insert Column. Repeat this to produce a
second empty channel

3. Right-click on the first empty cell, select the List option and then select Easting from
the list of hidden channels. Repeat this to display the Northing channel in the other
empty channel

Note that the Easting and Northing channels are not protected, like the other channels.
Channels are automatically set to Protected only when they are created by importing data,
otherwise you need to assign Channel Protection yourself.
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Display the Survey Line Path on a Map
Once the data is geolocated, it is a good idea to view the survey lines on a map to assess their
precision. We will now create a map and plot the line path on it.

1. Open the Map Tools menu and then select New Map from > X,Y. The Data range to
Map dialog appears

2. Click on the Scan Data button. This option will interrogate the database and populate
the dialog accordingly, which sets the extents of the map

3. Click Next>. The New Map dialog appears
4. Enter a name for the map in the Name field
5. Select an appropriate Map template. This configures the map based upon the chosen

oreintation and paper size. Landscape A4 is suitable for the sample data
6. Click Scale to calculate the smallest map scale that fits the template.
7. You can adjust the scale to the nearest round number that is greater than the

calculated scale (e.g. 5000 if you choose a Landscape A4 template)
8. Click Finish. This will create a blank, scaled, 2D map

Now we will plot the survey line path on the map.

1.9. Open the Map Tools menu and select Line Path, to open the Line Path dialog
10. Accept all of the default parameters and click OK to plot the line path
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We can also create a reference grid, north arrow, scale bar and title block for the map, by
creating what we call a Base Map.

11. Open the Map Tools menu and select Draw Base Map
12. In the Draw Base Map dialog, accept all of the default parameters and click Next.
13. In the second dialog, click Next and then click Finish to plot the base map.

Map elements such as the scale bar and north arrow can be moved around, by clicking on
them to select them, then dragging them to a different area of the map.

If you are happy with the map, press Ctrl_S to save the map.
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Display a Profile Window in a Database
Displaying geophysical data in a profile window can be very useful for identifying bad or noise
data, as well as for designing database filters. We will now display a profile window in the
database.

1. In the Flight01 database, right-click on the header cell of the Mag1Data channel
2. From the list of tools select Show Profile

The profile will be displayed in a profile window, which opens at the base of the database
window.

When you click on the profile, the cell containing the corresponding data value is highlighted. If
you have your map visible, the map cursor will also move to the corresponding location on the
line path.

Right-click within the profile window and explore the various options such as zooming and
changing the profile scaling.
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Applying a Filter to a Database Channel
Spikes and systematic noise can be removed from a database channel manually, but it is
easier to remove noise by using a combination of filters. We will now create a filter to remove
spikes from the sample data.

1. Open the Database Tools menu and select Filters > Despike Channel
2. Select the Input channel (Mag1Data) to despike and provide a name for the Output

channel
3. The Time channel will be set automatically should there be a channel with that name

in the database. Otherwise, select your time channel. The time data should be in units
of hours

4. The Over number of seconds channel is set to 3 by default, which should be
appropriate for removing spikes from your data, however you may need to adjust this
based on assessing the results

5. Click OK to run the filter

The resulting filtered profile is displayed in the same pane as the input profile. By default each
profile is scaled to fill the vertical space. If the extents of the profiles are very different you
cannot directly compare them (see pane "a" in the Figure below).

6. To display the input and output channels on the same scale, right click in the profile
window and select Y Axis Options

7. Select Same axis scale for all profiles then click OK

The profiles are now on the same scale, as shown in pane "b" of the Figure below. You will
likely not see much detail because the scale of the profile window is set to accomodate the
largest spike in the input data.

8. Manually reset the minimum /maximum in the profile pane by clicking on the numbers
at the left end of the profile window and typing a new value. For the sample data, a
minimum of 50000 and a maximum of 51000 work well (see pane "c" in the Figure
below)

You can also use the Zoom tool (right-click in the profile window and define a box around the
area of interest with your mouse) to get a closer look at profile sections, as shown in plate "d"
of the figure below.
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Please note also the following:

l The horizontal scale of the profile window is by default set to the fiducial channel (record
number) in the database, however it can be changed to a different channel by right-clicking
in the profile window and selecting X Axis Options.

l For the sample data, the output channel (green profile in the Figure above) is free of spikes
but also systematic noise, which has been removed using the Remove Systematic Noise
filter (Database Tools Menu > Filters > Remove Systematic Noise) to remove the high
frequency noise present in this data.
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Reducing the Size of a Database
Databases containing geophysical data are often large in size. There are a couple of ways in
which we can manage this in Oasis montaj Field, without affecting data quality:

l Decimating a database
l Compacting a database

Note that neither of these steps are required for the sample data.

Decimating a Database
Magnetic and other airborne data is often collected at very high frequencies, i.e. 1KHz, which
is often a lot higher than is required for interpreting geology. Oasis montaj Field allows you to
desample the data and make the database smaller, without losing the detail required for
interpretation.

Decimating a database can be done by opening the Database Tools menu, selecting Channel
Tools, and then selecting Decimate. The tool allows you to decimate the data by any factor
greater than one; a factor of two would remove every second sample and so on.

For more information on this tool, please refer to the application help.
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Compacting a Database
Compacting a database allows you to remove any data records that contain dummy values
from the database.

1. Open the Database Tools menu and select Compact Database
2. Select the channel(s) you would like to analyse to a new compact database. Data

records with dummies in any of these channels will be removed from the output
database

3. Click OK to run the compaction

When the output database is created, a popo up report will appear that informs you how much
smaller (as a percentage) the output database is compared to the original.
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Masking Flagged Data
Often when collecting data, a couple of "flag" channels are recorded, which indicate if satellite
coverage is sufficient for accurate positioning and if the sensor is functioning properly. Oasis
montaj Field offers a simple conditional tool that allows you to mask out sensor data
according to one or more flag channels. In the sample data, there are several such channels,
including FixQuality and Mag1Valid.

For the sample data, let's assume that a Mag1Valid value of 1 indicates the sensor is
operating properly. We could use the tool to create a conditional filter to mask out data that
does not satisfy this criteria:

1. Open the Database Tools menu and select Filters, then Mask to Channel
2. Select the Input channel
3. Provide a name for the Output channel, or select a channel from the list to write to
4. Create the Mask input condition as shown in the dialog below

5. Click OK

The act of masking in this case replaces the input data with a dummy value, where either of
the conditions are not met. In the example below, sections where the data have been masked
are highlighted.
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Removing Unwanted Survey Path Segments
All raw data from airborne surveys will contain data that is recorded while the aircraft is taking
off, turning around between survey lines and landing. The takeoff, turnaround and Landing
segments of the survey can be removed by creating a polygon file (or import one from ArcGIS)
that covers the desired area of interest, then windowing the database to the polygon, so that
data which lies outside the polygon is replaced by dummy values.

1. Ensure that the map created previously is selected
2. Open the Database Tools menu, select Window Data and then select Create Polygon

File

3. Provide a Polygon file name
4. Click New File
5. You will be prompted to draw the polygon on the map. Draw it to exclude the

undesirable segments (as shown in red below)

6. To display the polygon on the map, open the Map Tools menu and select Draw from
PLY file
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7. Load the polygon file you just created as the input
8. For contrast, select a colour other than black
9. Accept the other default parameters

10. Click OK
11. To window the database, open the Database Tools menu, select Window Data and then

Mask Channel to Polygon

12. Load the Polygon file and select the Channel to mask as Easting
13. Ensure that (in this case) that Dummy Outside is selected
14. Click OK
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Break Data into Separate Lines
Magnetic data that is recorded and imported into Oasis montaj Field as a single, continuous
line (such as the sample data) should be broken up into separate parallel flight lines for futher
processing and interpretation. This can be achieved in Oasis montaj field using several
different methods:

l Split a line based on a line channel (which contains line numbers)
l Split on X,Y breaks; data will be broken up based on assessing the data for gaps of a

specified size between X and Y coordinates
l Split on change in survey direction
l Split on fiducial numbers

As the sample data does not contain a line channel, the split on X,Y breaks method is the
easiest to use.

1. Open the Database Tools menu, select Line Tools and then Split on XY Breaks

2. In this case, we can simply specify a Down line distance tolerance of 5 metres. The
specified distance should always be shorter than the turnarounds

3. Set the line number syntax to Sequential
4. Leave the other parameters as they are
5. Click OK

The database is now broken down into individual lines, however the dummy segments that
coincide with takeoff, turnaround and landing zones are still included in the database. These
dummy segments can be eliminated in the process of creating a subset database:

1. Open the Database menu, select Export and then Subset GDB
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1. Provide a Subset database name
2. For the Remove mask dummies option, select All dummies
3. Set the Mask channel as Easting
4. Leave the remaining parameters at their defaults and click OK

Plotting a line path on the map now, using the subset database, will show the separated lines.



41

Gridding Sensor Data
Gridding the data allows us to look for signs that the sensor data suffers from effects such as
lag, heading or instrument drift. We will first demonstrate gridding in version 9.10 of Oasis
montaj Field, after which we will demonstrate the same process in version 2021.2, where the
gridding interface has changed significantly.

Gridding in Version 9.10
1. Ensure the correct (filtered, masked, line separated) database is selected
2. Open the Grid and Image menu, select Gridding and then Minimum Curvature

1. For the Channel to grid, select the appropriate database channel
2. Leave the Mask channel empty
3. Specify a name for the Output grid
4. Leave the Grid Cell size field empty. This allows the program to calculate an

appropriate cell size based on the gridding method and sample distribution across the
area of interest

5. Click OK

The grid will be created and displayed in a temporary grid window. We will display it on the
map shortly.

Gridding in Version 2021.2
1. Ensure the correct (filtered, masked, line separated) database is selected
2. Open the Grid and Image menu, select Gridding and then Grid Data
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The biggest change in the gridding interface is the presence of a preview window, which
allows you to see the effects of changing gridding parameters in real time.

3. For the Channel to grid, select the appropriate database channel
4. Specify a name for the Output grid
5. Choose an appropriate Gridding method. Bi-directional gridding is most appropriate for

data that is distributed along parallel lines, whereas minimum curvature allows for
more random data distributions (i.e. you could use it to grid the sample data before it
was broken into separate lines)

6. Leave the Grid Cell size field empty. This allows the program to calculate an
appropriate cell size based on the gridding method and sample distribution across the
area of interest

7. When the preview looks reasonable, click OK

Displaying the Grid on a Map
We recommend, when assessing the quality of gridded data, to display it on a map using
colour shading, which accentuates any problems that may occur in the grid, particularly when
displayed in conjunction with the survey line path.

1. Ensure the correct map is selected
2. Open the Grid and Image menu, select Display on Map and then Grid
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3. For the Grid name, select the desired grid from the drop down menu (all grids in the
current project will be shown)

4. Check the Shading option
5. Leave the other parameters as they are
6. Click Current Map

The grid will be displayed on the map.

When inspecting the data, you may notice:
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l Altitude deviation observed as a change in the amplitude of the the same anomaly on
adjacent lines

l Flight line separation manifested as irregular gaps between survey lines that should
otherwise be parallel and equidistant

l Sample separation manifested as change in the resolution along line
l Drift issues manifested as a long wavelength trend
l Heading issue manifested as local anomalies directly correlated to the line path and

direction
l Time lag manifested as herringbone between survey lines
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Running QC Tests
The QC Tools menu offers a set of comprehensive tools to eliminate and/or minimize the
problems with the data described on the previous page. Depending on the nature of the
problem to correct, you may also revisit the filters in the Database Tools menu. If none of
these tools exactly cater to the need, then explore the Channel Math tool in the Database
Tools menu and apply your own math expressions to the data.

In this section we will describe the Lagcorrection tool. Lag errors are caused by the differing
positions of magnetometer (or other) sensor and positioning equipment within the aircraft and
possible electronic delays in recording one or both values. Lag in magnetic data manifests as
changes in the location of edges of an anomaly between adjacent survey lines, as highlighted
by the white arrows in the image on the previous page. It is often referred to as a "herringbone
effect" because of the appearance.

Performing a Lag Correction
1. Ensure that the database and the map are open and selected
2. Open the QC Test menu, select Corrections and then select Lag

3. Select the appropriate Channel to lag from your database
4. Provide an Output channel name
5. Provide the number of fiducials representing the Lag shift

The lag shift can be estimated by choosing an anomaly in the data that crosses several
survey lines, then measuring the offset from line to line using the Measure Distance tool,
which can be launched by right clicking on a map. You will need to understand the direction in
which the survey lines were acquired. A positive lag will shift the data back in time, and
negative lag will shift the data forward in time.

6. Click OK
7. Proceed to grid the output channel and display it on the map. You would expect the

herringbone effect eliminated or subdued, as shown below
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You are invited to explore the other correction tools as they all follow a similar logic to the Lag
tool.
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Accessing Public Geoscience Data
Oasis montaj Field allows you to download and overlay Azure Maps satellite imagery, terrain
grids, and vector files delineating natural and infrastructure outlines. Data can be accessed
from the Data Services menu, which offers two options:

l Seeker - this option launches a tool which lets you search for and download various
geoscientific data, which is hosted on our public DAP server. If you have a map open when
you launch it, Seeker will automatically search based on the extents of the map. Within
Seeker you can also connect to other public data repositories, such as Web Map Services,
which many government agencies use to share data

l Add Azure Maps Imagery - the option allows you to display Azure Maps satellite imagery
onto your map

Now we will cover how to display Azure Maps imagery on the map.

1. Ensure your map is open
2. Open the Data Services menu and select Add Azure Map Imagery

3. Select the Imagery type Aerial
4. The imagery is added to the map
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5. Expand the Map Manager tab at the top left of the map to view the data layers

6. You can use the Map Manager to move map layers up/down, turn them on/off and set
their transparency. More information can be found the help file

In the above example, the Map Manager is pinned open. The magnetic grid layer has been
moved above the Azure Maps imagery within the Data View, so it is visible. A 60%
transparency has been applied to the magnetic grid so the satellite imagery can be seen.
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Working with 3D Views
3D Views allow you to view and integrate data in three dimensions. In Oasis montaj Field, you
can plot a 3D line path from your survey database, plot geophysical data as 3D aware symbols
and overlay gridded data on a 3D relief surface.

Data in a 3D view is linked to both maps and databases, allowing you to easily view, track and
analyse your data.

A relief surface requires a grid that contains topographic elevations across your area of
interest. This can be created by gridding sensor elevation data from your data (and subtracting
the flight height if necessary), or through downloading a SRTM grid for your field area from
Seeker. Here we will walk through how to create a new 3D view and add data such as a relief
surface and a 3D line path.

1. Open the 3D View menu and select New
2. Provide a Name for the 3D View and click OK. An empty 3D view is created
3. In the 3D view, open the Add to 3D menu and select 3D Line Path
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4. Accept the default parameters and click OK. The survey path is displayed in the 3D
view

5. Open the Add to 3D menu and select Relief Surface

6. Provide a Surface relief grid (gridded topography data)
7. Provide the Colour image grid (e.g. gridded magnetic data)
8. Accept the remaining default parameters and click OK
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The magnetic data grid is displayed in three dimensions along with the survey lines. Take
some time to familiarise yourself with navigating the 3D view, using your mouse (and mouse
wheel) along with the navigation tools provided on the 3D view toolbar. More information on
these tools can be found in the Application help.
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Merging Databases
Geophysical surveys can occasionally be divided into sub areas, within which data is acquired
independently of the other sub areas in the survey. In such cases, where each sub area is
processed separately, you can use Oasis montaj field to merge the databases into a single,
master database:

1. Open the Database Tools menu and select Merge Databases

1. Provide the name of or load the Database to modify (i.e. the master database)
2. Load the Database(s) to merge (you can load multiple databases by Ctrl+selecting

them using the browse tool)
3. Accept the remaining default parameters and click OK
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